
FAQ's

SOAPware, Inc.



FAQ's

Billing Specific1

Q: How do I add modifiers to the existing modifiers list? 91.1

Q: What is a Related Dx SMARText item? 101.2

Database2

Q: What is the PostgreSQL database top capacity? 122.1

Q: How do I backup my database? 132.2

Document Designer3

Q: How do I create a new Document Design in Document Designer? 153.1

Q: How do I designate a document design as an Order? 173.2

Q: Where are the "Save To" or "Insert" data commands in Document Designer? 203.3

Q: How do you put a signature on a Print Report? 233.4

Document Review 4

Q: I am unable to access the Document Review workspace. The menu item is 
grayed out. Why?

284.1

Docuplates5

Q: How do I create a Normal Exam docuplate? 305.1

Q: How do I create a docuplate? 345.2

Q: Can I use Document Designer commands in my docuplates? 355.3

Drug Interaction Notifications6

Q: Why am I receiving an interaction notice? 436.1

Q: How do I change the severity level of Drug Interaction Notifications? 446.2



EM Coder7

Q: Why is the Level of Risk the color red in EM Coder? 517.1

Q: How do I enter a Chief Complaint that will register in the EM Coder? 527.2

Q: What does the methodology tab display in the EM Coder? 567.3

Faxing8

Q: How can I fax directly from SOAPware? 588.1

Font9

Q: How can we make the font for writing text on scanned or imported 
documents default to a larger size font? 

619.1

Q: How do I change the font in SOAPware? 659.2

Interface Specific10

SOAPware compatible Labs and LIS software/services 7110.1

Q: How does the SOAPware-Phreesia Interface work? 7710.2

IT Specific11

Q: Do we have to update SOAPware on all computers? 8111.1

Q: How do I optimize SOAPware over an RDP Connection? 8211.2

Miscellaneous12

Q: How do I create a mailing label? 8512.1

Q: How do I remove a document? 8912.2

Q: What are document demographics? 9112.3

Q: Why is my patient's chart empty? 9212.4

Q: How do my nurses let me know when a patient is ready to been seen? 9412.5

Q: How can I tell what version of SOAPware I am running? 9512.6



Q: Can I run SOAPware on a Mac computer? 9612.7

Orders13

Q: Are there examples of orders available on the SOAPware Cloud Library? 10213.1

Q: How do I remove or add Order Entry sub-items that display in the Plan field? 10613.2

Q: How do I remove the sub-items shown in Order Manager? 11113.3

Pick Lists14

Q: When I make a change to a pick list within a docuplate, why does this 
change not reflect when I insert the docuplate again into the SOAPnote?

11714.1

Q: Why can I not deselect a pick list item after inserting it? 11814.2

Prescriptions15

Q: How do I set up ePrescribing? 12015.1

Q: How do I change the prescription report printed from Rx Manager? 12515.2

Q: How do I build a multi-page prescription? 12615.3

Q: When a prescription is faxed through the Rx Manager, what format is it in? 13115.4

Q: How do I add the office fax number to printed prescriptions? 13515.5

Q: How do you put a prescription on hold? 13915.6

Q: How do you add a provider's signature to an electronically prescribed 
prescription?

14215.7

Q: Can you generate a prescription without having to create a new SOAPnote? 14315.8

Printing16

Q: How do I print notes for a Medicare Audit? 14516.1

How do I include all documents in a docutainer when I use the quick print 
method?

14816.2

Q: How can handouts print automatically with other Document Designs? 15016.3

Q: How do you make a Document Design print at a specific printer? 15616.4



Refill Requests17

Q: How should I respond to a controlled substance refill request? 16417.1

Q: How do I remove a refill request? 16517.2

Q: Why do pharmacies send refill requests for scheduled medications if they 
cannot be refilled electronically? 

16617.3

Q: Why am I not receiving electronic refills from the pharmacies that 
automatically match with the patients in SOAPware? 

16717.4

Sales Specific18

Q: Does SOAPware offer a return period? 16918.1

Q: How do I see my SOAPware license? 17018.2

Q: How many office staff can use each SOAPware license? 17318.3

Q: How many computers can I install SOAPware on? 17418.4

Security19

Q: Is there a way to lock users out of the ability to customize or reset toolbars? 17619.1

Q: Why does my newly created chart section not show up in Chart Navigator? 17719.2

SOAPware Cloud Solution20

Q: On the SOAPware Cloud Solution, how do I control the size of my screen?  17920.1

Q: How do I logout/disconnect from my SOAPware ASP Server? 18220.2

Q: How do I import images into a chart via the Remote Desktop?  18420.3

Q: How do I connect to the SOAPware Cloud server?  19020.4

Q: How do I print from a Remote Desktop Connection (RDC)?  19320.5

Q: How does a Remote Desktop Connection "Session" work?  19520.6

Q: How do I scan into SOAPware on the SOAPware Cloud Solution? 19720.7

Q: What controls the speed of my ASP server?   19820.8

Q: Why won't printers load into a Remote Desktop Session? 19920.9



Q: Can I run SOAPware on a Mac computer through SCS? 20020.10

SMARText21

Q: What do the triangle colors next the SMARText Items mean? 20621.1

Q: How do I change a SOAPware created shortcut code to my own shortcut 
code? 

20721.2

Q: Why do some words expand into text when I don't want them to, and how do 
I resolve this issue?

21021.3

Q: How do I use existing SMARText items as the basis for new ones? 21321.4

Q: How do I add a comment or free text to a structured item? 21721.5

Q: How can I change the wording and appearance of SMARText in my 
documentation? 

21921.6

Q: How do I update SMARText items? 22221.7

Q: Why do I get a "Connection Failed" error when attempting to update 
SMARText? 

22521.8

Q: Is there a good way to download a large amount of structured medications 
at once? 

22721.9

Q: How do I load the SMARText Quick Access with my top SMARText items?  23121.10

Summary/SOAPnote Specific22

Q: How do I clear/empty a field under a field header in the Summary or a 
SOAPnote?

23322.1

Q: How do I add or remove the Provider name in the Follow Up field? 23422.2

Q: Can I hide or remove certain field headers in the Summary or SOAPnote 
chart sections?

23622.3

Q: How do you reassign ownership of a SOAPnote to another Provider? 24322.4

Q: How do I import my signature directly into the SOAPnote or Encounter? 24522.5

Q: How do you document phone calls and/or e-mail messages received from 
patients?

25022.6

Q: How can a patient's past visits be viewed while also viewing the current 
encounter? 

25122.7



Q: How do I enter "Electronically Signed By" into my SOAPnote? 25522.8

Support Specific23

Q: I renewed my support agreement but still get a pop up asking me to renew. 26023.1

Version 424

Q: How do I convert my old V4 shortcut codes into structured SMARText items? 26324.1

Q: When reassigning V4 shortcut codes to a structured SMARText item, how 
can this change be permanent? 

26924.2

Q: Why are my print reports from V4 not printing out the patient's 
name/dob/address in SW 2012?

27024.3

Q: Where are my templates from Version 4? 27524.4

Vital Signs25

Q: How do you add another Vital Sign to the Vital Signs chart section? 27825.1



SOAPware, Inc.FAQ's - 8

Billing Specific
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Q: How do I add modifiers to the existing modifiers list? 

A: Users do not have the ability to add to the existing modifier list.  This list is defined by CMS and 
is not editable.  
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Q: What is a Related Dx SMARText item? 

A: The Related Dx SMARText item is used to indicate the diagnosis code(s) that relate to the 
particular CPT code in the SOAP encounter note. 

Explanation of Related Dx SMARText item

The diagnosis codes that are entered into the Assessment field within the SOAPnote, or in the 
patient's Summary Active Problems field, will display in the SMARText Quick Access when the 
Related Dx header is left-clicked over within the Plan field. 
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Database
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Q: What is the PostgreSQL database top capacity?

A: PostgreSQL is the database included with SOAPware. Postgre SQL is capable of handling the 
medical records for millions of patients and thousands of clinicians.

Actually, the largest and busiest database in the world is PostgreSQL. See the link below for more 
information on PostgreSQL.

Computer World

http://www.computerworld.com/s/article/9087918/Size_matters_Yahoo_claims_2_petabyte_database_is_world_s_biggest_busiest
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Q: How do I backup my database?

A:  Please see the following links for information on backing up your SOApware database:

• Backing Up SOAPware Data

http://soapware.screenstepslive.com/s/documentation/m/installation_guide_current/l/26115-backing-up-soapware-data
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Document Designer
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Q: How do I create a new Document Design in Document Designer?

A: To begin creating a new Document Design, the Document Designer window will need to be 
opened (Tools > Document Designer).

Click on File >  Create New Design. Give the new Document Design a Document Name.
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To use an existing Document Design to modify, Click the selection, Copy of . To create a 
Document Design using a blank document, Click to select, Blank Document. Click OK.

The new Document Design will display. A user can then edit/create the document by using data 
command items, entering text, macros, or images for clinic logos.
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Q: How do I designate a document design as an Order?

A: A user is able to designate a document design as an Order through Document Designer.

Open the Document Design that needs to be designated as an Order.
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With the Design open:
1. Click Edit.
2. Click Design Properties.

1. Click on the Design Types tab.
2. Select Order Design.
3. Click OK.
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Upon closing the design, there will be a prompt to save any changes.
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Q: Where are the "Save To" or "Insert" data commands in Document Designer?

A: These commands are found within Design Properties in Document Designer. (Tools > 
Document Designer)

1. Click Edit.
2. Click Design Properties.
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1. Click the Destination tab.
2. Select "Save a copy to."
3. Click the "Choose" button to select a chart section.



SOAPware, Inc.FAQ's - 22

Click to highlight the chart section of choice, then Click Select.

The option to give the Document Design demographic information is available. If no information is 
entered, Click OK. A window will prompt the user to save the changes to this design upon closing 
the design.  
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Q: How do you put a signature on a Print Report?

A: To place a signature on a print report or Document Design, use Document Designer, if there is 
a signature imported previously, into Provider Manager.

1. Click on Tools.
2. Click Document Designer.

1. Click on File.
2. Click Available Designs.
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Click to highlight the Document Design to add signature, and Click Ok.

Place cursor at location of choice for signature insertion.
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1. Click on Data Items.
2. Click Misc. Data Items.
3. Click Clinician.
4. Click Signature.

The Data Command is placed in the Document Design where the cursor was last placed. This 
will pull the Clinician Signature image that is in Provider Manager, onto the design.
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1. Click Close.
2. Click Yes to save changes to the Document Design.
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Document Review 
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Q: I am unable to access the Document Review workspace. The menu item is grayed 
out. Why?

A: When a menu item is grayed out, the user has not been given security access for this function. 
A SOAPware user with Administrator rights has the ability to give security access within 
SOAPware, to other users.
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Docuplates
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Q: How do I create a Normal Exam docuplate?

A: To set normal findings for a Normal Exam docuplate, a user would need to create this 
docuplate from a test patient's chart.  

In the Objective field, use the shortcut code "obj-", then press the spacebar to expand information. 
If this SMARText item has never been used, it will need to be searched  by pressing the Shift + 
F11 keys, to be inserted into the SOAPnote.
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The SMARText body system pick lists for the exam will display. By default, this will enter a "normal 
exam".
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Left- click on a body system sub-header, to change the findings from normal to another identified 
finding.

When a user is finished with the creation of a Normal Exam docuplate, Click F6 on the keyboard, 
to bring up the Docuplates dialog. 

Click on the create button, and then give the new Normal Exam docuplate a shortcut, description, 
and keywords. 
Lastly, Click on OK.
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The Normal Exam docuplate is now available for use for all users on a local network.
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Q: How do I create a docuplate?

A: Click on the link below to learn how to create a docuplate.

Create a Docuplate

http://soapware.screenstepslive.com/s/documentation/m/new_user_manual_current/l/24593-creating-a-docuplate
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Q: Can I use Document Designer commands in my docuplates? 

A: Yes, Document Designer commands can be place in a temporary Document Design, and then 
copied and pasted into the docuplate. 

Access Document Designer

1. Click on Tools.
2. Click on Document Designer.
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Create the Temporary Design

1. Click on File.
2. Click on "Create New Design."
3. Name the Design.
4. Click OK.
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Access the Desired Commands 

1. Click on Data Items.
2. Click on the desired commands, one at a time, to insert into the temporary design. 
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Incorporate Free Text 

Free Text can be incorporated between the data commands. 
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Copy and Paste the Commands

1. Click and drag the cursor over the text-to highlight the text.
2. Click on Edit.
3. Click on Copy.

1. Click on Close.
2. Click on "No" since this is a temporary Document Design.
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Place the Commands in the Docuplate

Access the docuplate the commands are to go in.  (NOTE: You will want to access the desired 
docuplate from the Docuplates tab-or press F6 on the keyboard--and insert the commands in the 
preview pane-to the right of the docuplate name. This will ensure that your changes/additions will 
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be saved for good.)
 Click the cursor where the commands are to reside.  Right-click and select Paste. 

Results

When the Docuplate is inserted into a SOAPnote, for example, the information will be pulled from 
the patient's demographics. 
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Drug Interaction Notifications
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Q: Why am I receiving an interaction notice?

A: When opening the Rx Manager, drug interactions are checked. If there are any drug interactions 
for this patient, an interaction notice will be displayed. Many times, a notice will occur due to 
unstructured text being entered in the Summary Medications field, Allergy field, or possibly the 
SOAPnote Medications field.

If there is unstructured text in any of these areas that should be retained, it is best to enter 
"ID-ignore" at the end of the free text, to be excluded from drug interaction checks. The shortcut 
code for "ID-ignore" is: id-, then press the spacebar to expand.
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Q: How do I change the severity level of Drug Interaction Notifications?

A: Designating or editing the Drug Interaction Notification is a user-specific setting, that can be 
defined in Security. 
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Tools > Security 

1. Click on Tools on the menu bar.
2. Click on Security.
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Selecting the User

1. Click on the plus sign (expander node) next to Users.
2. Click to highlight the users name.
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Rx Manager

1. Click on the expander node next to the users name.
2. Click on the expander node next to Displays.
3. Click to highlight Rx Manager.
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Defining Alerts

At this point, the user can select "Allow All" or "Deny All."
By clicking directly in the check boxes next to the severity alert, the user can place a red X (to deny 
access) or green check (to allow access). 
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Save the Selections

1. Click Close.
2. Click OK.
Logout of SOAPware, and back in for these changes to make effect. 
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EM Coder
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Q: Why is the Level of Risk the color red in EM Coder?

A: The level of risk is automatically calculated for the user based on information found in the 
SOAPnote. The color red indicates to the user that the level was calculated by SOAPware and that 
the user should review the SOAPnote to ensure that the value is correct. If the user changes the 
level of risk manually,  the color will change to black. 

Note: It is very important for the user to always review the level of risk finding, as there are many 
rules and conditions that SOAPware cannot account for.
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Q: How do I enter a Chief Complaint that will register in the EM Coder?

A: It is important to understand that the EM Coder mostly uses SMARText for all of its scoring, and 
the Chief Complaint is no exception. To enter a Chief Complaint a user must use a SMARText 
item of the Chief Complaint type.

Open a new SOAPnote and place the cursor in the Subjective field.
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Type "chix" into the Subjective field and press the Shift + F11 keyboard command.

The Chief Complaint(s)/Reason For Visit SMARText pick list is now inserted. 
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Left-click on the Chief Complaint SMARText item and Select a description from the SMARText 
Quick Access window. Most commonly, the "Most Common Chief Complaints" is chosen.
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Click to select "Back Pain" as the Chief Complaint to get started using the EM Coder.
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Q: What does the methodology tab display in the EM Coder?

A: The methodology tab gives a detailed list of information on how the EM Coder is scoring the 
different systems that make up the probable level of service. This tab is intended for read-only and 
for informational purposes.
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Faxing
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Q: How can I fax directly from SOAPware?

A: Users are able to transmit faxes directly from SOAPware when using the SOAPware Faxing 
Module and designs from Available Document Designs. 

Note: This is a fax- out only ability; faxes cannot be received through SOAPware. 

The SOAPware Technical Support Department will receive a message when a fax was not 
transmitted successfully. They will try to send the fax again manually. If this transmission fails, 
Support will contact your office.

Click to highlight the Document Design to fax.
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The Fax Contact window will display. 
1. Select the contact to fax the design to. 
2. Click the "Fax" button to send.
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Font
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Q: How can we make the font for writing text on scanned or imported documents 
default to a larger size font? 

A: A user can set a default font size for text  per  document. There is not currently a way to set a 
default font size that will hold every time you scan or import a new document. 

Activate the Document

 Click on the document to activate the document.
 Right-click on the document, then choose Default Properties.



SOAPware, Inc.FAQ's - 62

Select the Font Tab

1. Click the Font tab.
2. Click Change.
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Set the Font Size

1. Choose the font size by  selecting the desired size font.
2. Click OK.
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Apply the Font Size

1. Click Apply.
2. Click OK.
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Q: How do I change the font in SOAPware? 

A: It is not possible to change the font of a single word or group of words due to the complexity of 
SMARText within SOAPware. A user can, however, change the overall font in the display. This is a 
user-specific setting. 
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Tools - Options

1. Click on Tools.
2. Click on Options.



SOAPware, Inc.FAQ's - 67

Choose SMARText

Click to highlight SMARText.

Formatting

Click on the Choose Font bar.
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Select the Desired Font

1. Choose the Font, Font Style, and Size by selecting/highlighting the desired items. 
2. Click OK. 
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Finalize Changes

1. Click Close.
2. Click OK.
3. Logout and back into SOAPware for the changes to take effect. 
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Interface Specific
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SOAPware compatible Labs and LIS software/services

Here you will find a list of lab companies and Lab Information Systems (LIS) that currently have 
interfaces and are compatible with SOAPware?

• 4Medica/CPL

• Accenx

• ACL Laboratory*

• ACM Medical Laboratory

• AEGIS Lab

• AEL Laboratory*

• AIM Labratories*

• Ameripath

• Ameritox Medication Monitoring Solutions

• Anrtim Labs*

• Atlas Medical Software**

• Aurora Diagnostics

• Avisena Practice Management

• Axolotl-OptumInsight**

• Bon Secours Lab*

• BioReference

• CareEvolve**
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• CBLPath

• CDI Radiology*

• Centrex Clinical Laboratories

• Cerner Corporation (Millennium, CoPath)**

• Certify Data Systems**

• Central Coast Pathology*

• Circa Design**

• Comtron**

• Corepoint Health**

• CPSI ChartLinc EMR Portal**

• Cognoscenti Health Institute/CPL*

• CriticalKey**

• Dianon/Labcorp

• Dynacare Laboratories*

• DVA Labs - Division of Total Renal Laboratories*

• Ellkay**

• Emdeon**

• Enzo Clinical Labs*

• Foundation Laboratories*
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• Halfpenny Technology**

• HCA Healthcare

• McKesson's Horizon Lab LIS

• Healthlab/Central Dupage*

• HEALTHeLINK*

• Healthland

• Health Diagnostic Laboratories

• Health Network Laboratories 

• Interbit Data**

• Intermountain Healthcare*

• Labcorp

• LabDAQ**

• LIGOLAB**

• Fletcher Flora Labpak**

• LabTrak LIS**

• Labpak LIS (Merge Healthcare)**

• Legacy Health*

• Lifepoint Informatics**

• Medcom Lab Manager
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• Meditech**

• Medical Diagnostics Laboratories

• Medicity**

• MedLink

• Medstar Laboratory Inc.*

• Merge LIS**

• Mesa Lab Equipment (Interpath)

• MobileMD**

• Munson Healthcare Systems*

• North Shore LIJHS*

• Northern Plains Lab*

• Novo Innovations**

• Orchard Software**

• OURLab

• Pacific Physicians Lab*

• Paragon**

• Pathologists Regional Laboratory*

• Pathology Associates Medical Laboratories

• Pathology Inc.*
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• PeaceHealth Laboratories* (formerly Oregon Medical Labs)

• Physicians Medical Laboratories*

• Providence Laboratory Services*

• PROLIS**

• PeaceHealth Laboratories/Oregon Medical Labs*

• Quest Diagnostics

• RADNET Inc.

• Relay Health**

• Rhode Island Medical Imaging*

• SchuyLab LIS**

• Sheil Medical Labortory*

• Solstas Lab Partners (formerly Spectrum/Carilion Labs)

• Steinberg Diagnostic Medical Imaging*

• S.T.A.R. Radiology*

• Steinberg Diagnostics Imaging Centers*

• Sunrise Medical Laboratories*

• TriCore Reference Laboratories*

• United Laboratories Inc.

• UniPath*
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• Westcliff Medical Labs*

• West Pacific Medical Laboratories*

*Indicates regional/local lab

** Indicates regional/local lab via LIS listed 

Note: 
The SOAPwareXchangeHL7 also interfaces with many other local hospital/regional labs. If you do 
not see your lab listed, contact SOAPware at 800-455-7627.
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Q: How does the SOAPware-Phreesia Interface work?

A: This lesson will provide the user with a brief description of the SOAPware-Phreesia interface, 
and its capabilities. 

What is Phreesia?

Phreesia, the patient check-in company, helps medical practices increase cash flow and save 
staff time. The solution, which checks in millions of patients every year, digitizes the check-in 
process by replacing the traditional patient clipboard and all paper forms with the wireless, 
touchscreen PhreesiaPad. Phreesia electronically collects and updates critical patient 
information, verifies insurance, and collects co-payments and balances during check-in. The 
solution also offers a number of flexible and convenient payment options for patients, including 
online payments and automated payment plans, further streamlining workflow for practices and 
helping them get paid in full and on time. Learn more at http://www.phreesia.com. 

http://www.phreesia.com
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How does the interface work?

Behind the scenes, Phreesia communicates with SOAPware via the SOAPwareXchange 
enhancement. 

When the patient enters the office, they are given a PhreesiaPad to enter their data. When 
finished, the patient will hand the PhreesiaPad back to the front office staff. During this process,  a 
file is also sent to the SOAPwareXchange for importing into SOAPware via the network. 

http://soapware.screenstepslive.com/s/documentation/m/interface/l/35324-SOAPwareXchange-User-Guide
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Where will the Patient Information entered on the PhreesiaPad be located in SOAPware?

 Demographics are transferred to their respective chart section in SOAPware.   Demographics 
can also transfer from SOAPware back to Phreesia if enabled. 
 A new SOAPnote will automatically be created, and the clinical data the patient entered into the 
PhreesiaPad, will be found in the Subjective field. A task associated with this SOAPnote will also 
automatically be created and assigned to the appropriate provider.

If the patient does not already exist in SOAPware, his/her chart will automatically be created. If a 
patient does exist in SOAPware, then any updated information will be imported from the 
PhreesiaPad. 
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IT Specific
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Q: Do we have to update SOAPware on all computers? 

A: The answer is yes; all machines need to be updated. In order for SOAPware to run most 
efficiently, all computers should be on the same version of SOAPware. Otherwise, with different 
versions of SOAPware installed, it could cause problems with SOAPware running well.
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Q: How do I optimize SOAPware over an RDP Connection? 

A: To optimize the speed of SOAPware over a RDP connection (i.e. Citrix Metaframe, Microsoft 
Terminal Service, VPN etc) you can edit the SOAPware shortcut and add an argument for turning 
off the background image which can render slowly. 

Create the Argument

Right-click over the SOAPware shortcut icon, and Select Properties. 
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In the Target Location box, type:
 
"C:\Program Files\SOAPware\SOAPware\ShowSplash.exe" -j SWSplash.jpg -e "soapware.exe 
-displayimage=n" -f xxxx - t 1 
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Miscellaneous
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Q: How do I create a mailing label?

Custom Patient Demographic Reporting for a Mailing Label

Open the Custom Patient Reporting by clicking on the View menu, then select Reporting.
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1. In the Demographics section under Last Name, specify the range of patient's that you wish to 
export for the mailing labels (Ex: if you wish to create mailing labels for all patients, enter A in 
the first box and Z in the second).

2. Click View Report.
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Export the Report

Export the report to a CSV or Excel File by clicking on the Export To button, then select either XLS, 
XLSX or CSV.

If CSV is selected, define the export options and then click OK. 
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This will export the file to an Excel/CSV file.  From here the columns/rows can be edited so that 
they only include the data that is needed to create mailing labels.  This file should be saved as an 
Excel file and then imported into Microsoft Word when the Mail Merge to create the Labels is 
created.
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Q: How do I remove a document?

A: Unsigned documents can be easily removed from the chart. Removing Signed off documents 
must be performed with caution. Once a document has been removed from SOAPware, it can no 
longer be retrieved. Clicking the "Remove Documents" button, or using the keyboard command 
Control + ALT + R, will remove the documents. The user will be prompted to verify this action 
before completion.

The user must have the appropriate security permissions to use this feature. 

The above imagine demonstrates how to remove a document, while viewing the document.
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This image demonstrates how to remove a document from within Chart Navigator.
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Q: What are document demographics?

A: The document demographics section is located in most chart sections, separated from the 
document by the upper splitter bar. The upper splitter bar may be expanded or collapsed, to view 
the document demographics. Demographic information can vary from one chart section to 
another.

Click the upper splitter bar to view document demographic information for the SOAPnote chart 
section.

The image above displays document demographic information for the SOAPnote chart section. To 
close/hide the document demographics, Click the upper splitter bar.
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Q: Why is my patient's chart empty?

A: A chart will appear empty if all of the chart sections have been closed. 

Clicking on the "X" located next to the chart section tabs, will close the active chart section.
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Click Yes or No to the prompt shown in this screenshot.
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Q: How do my nurses let me know when a patient is ready to been seen? 

A: The information can be entered into the Add Document Task dialog. Room numbers can be 
created in the Action/Status column to reflect the exam room the patient is in, and the time the 
patient was checked in can be typed in the description line.  

Add Document Task Screen Dialog

**Remember, this dialog is derived from clicking the Add New Docutainer button.
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Q: How can I tell what version of SOAPware I am running? 

A: SOAPware currently has different versions, and within those versions are different builds of 
SOAPware. 

Check the Current Version of SOAPware

1. Click on Help on the menu bar.
2. Click on "About SOAPware."

A dialog box will appear with the current version and build of SOAPware. 
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Q: Can I run SOAPware on a Mac computer?

A:  Yes, a windows-based application like SOAPware can be run locally on a Mac computer with 
the aid of a tool like Parallels Desktop, or VMware.

*Note: If you should need any type of technical assistance regarding the use of Parallels Desktop 
or VMware products, please seek out support from the respective companies.

For this article, we will refer to using Parallels Desktop.

Parallels Desktop

Double-click on the Parallels Desktop icon.

Launch Windows

Insert your log in and password for windows.

http://www.parallels.com/products/desktop/
http://www.vmware.com/products/workstation/overview.html
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Parallels Desktop Preferences

1.  In the top toolbar, Click Parallels Desktop > Preferences.
2.  Uncheck the box next to "F6" since that is a function key used in SOAPware.

System Preferences 

Double-click on the System Preferences icon at the bottom of the screen.
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System Preferences- Keyboard

1.  Click on "Keyboard."
2.  Check the first box that refers to the standard function keys.

Checking this box will allow the Mac user to still use the function keys for their intended function, 
however the Fn key must be pressed first on the keyboard, and then select a function key at the 
top of the keyboard.
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System Preferences- Mission Control

1.  Click on "Mission Control."
2.  Reset the "Show Desktop" option (which will be set to F11) to a function key that is not already 
used in SOAPware, such as F15. 
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Launch SOAPware

Double-click on the SOAPware icon. You may then log in and proceed to use the function keys on 
your keyboard, to bring up the intended actions in SOAPware.

*Note: Should a user need to install SOAPware on either the Parallels Desktop or VMware, please 
refer to our downloads article.

http://soapware.screenstepslive.com/s/documentation/m/download
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Orders
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Q: Are there examples of orders available on the SOAPware Cloud Library? 

A: Yes, there are several SMARText Order Items available to download. 

Accessing the SMARText Items Manager 

1. Click on Docutainers.
2. Click on SMARText Items .

A user can also press F10 on the keyboard, to pull up the SMARText Items Manager. 
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Searching for SMARText Orders

1. In the Find box, type in the shortcut code "S---" (S and 3 dashes).
2. Click on the Find (magnifying glass) button.  Make sure "Include Cloud Library Items" is 
checked at the bottom right of the SMARText Items Manager.
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Selecting the Items

Click to highlight the first order Item with a downward facing triangle and, holding down the Shift 
key on the keyboard, click to highlight the last order Item with a downward facing arrow, to be 
downloaded. This will highlight all the SMARText Order Items in between. 
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Downloading the SMARText Items

With the desired items highlighted, click on the blue download arrow button.
This will download the items into the local database for use by all users on the local database.
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Q: How do I remove or add Order Entry sub-items that display in the Plan field? 

A: Adding and removing Order Entry sub-items that are displayed in the Plan field is 
accomplished under the Tools >  Options menu, and is a user-specific setting. 

When a user changes a sub-item to either display or not display in the field, those changes will 
only be reflected with new orders that are inserted into the Plan field. Orders that are already in the 
Plan field, prior to these changes, will not be effected. 
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Tools - Options

1. Click Tools.
2. Click Options.
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Structured Order Entry

1. Click on Structured Order Entry.
2. Select the Plan tab.
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Selecting the Sub-Items

Click to place a check mark in the box next to each sub-item that will appear in the Plan field. 
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Saving the settings 

1. Click Close.
2. Click OK and logout of SOAPware for these changes to take effect.
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Q: How do I remove the sub-items shown in Order Manager? 

A: Adding and removing Order Entry sub-items that are displayed in Order Manager, is 
accomplished under the Tools > Options menu, and is a user-specific setting. 

When you change a sub-item to either display or not display, those changes will only take effect 
on new orders that insert into Order Manager. Orders that were already in Order Manager, prior to 
these changes,  will not be effected by the new settings. 
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Tools - Options 

1. Click on Tools on the menu bar.
2. Click on Options. 
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Structured Order Entry

1. Click on Structured Order Entry.
2. Select the Order Manager tab.
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Selecting Sub-Items

Click to place a check mark in the box next to each sub-item that will appear in the Order Manager. 
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Saving the Settings 

1. Click Close.
2. Click OK and logout of SOAPware to save the settings. 
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Pick Lists
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Q: When I make a change to a pick list within a docuplate, why does this change not 
reflect when I insert the docuplate again into the SOAPnote?

A: In order for changes to a pick list in a docuplate to become permanent, edits will need to be 
made in the Docuplate display window.

1. Docuplates window
2. Docuplate view window
3. SMARText Pick List Items
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Q: Why can I not deselect a pick list item after inserting it? 

A:   Pick lists should only be used with structured items. When free text or unstructured items are 
used to make a pick list, SOAPware cannot tell one item from another. Thus, when the 
unstructured item or free text item is inserted into a field, the pick list can't find it to remove it.
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Prescriptions
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Q: How do I set up ePrescribing?

A: In order to set up ePrescribing correctly, look to the five steps outlined below.

Step 1: Register to ePrescribe

Within our new Help Manual training resource within SOAPware, you will want to access the 
Register to ePrescribe lesson by going to Help > How do I and type in "Register to ePrescribe" 
and click the magnifying glass.  Click here to learn more about our Help Manual.  

http://soapware.screenstepslive.com/s/documentation/m/new_features/l/70354-new-activity-workflow-based-training-resources
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Step 2: Access Provider Manager

You will want to access Provider Manager (Tools > Provider Manager) to fill in the provider's DEA 
number among other fields for ePrescribing purposes.  Please see: Provider Manager. 

http://soapware.screenstepslive.com/s/documentation/m/new_user_manual_current/l/24521-provider-manager
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Step 3: Pharmacy Setup

Prior to sending prescriptions electronically or faxing to a participating pharmacy, Pharmacies 
must be set up in the Pharmacy Manager (Tools > Pharmacies).  Please see: Pharmacy Setup.

http://soapware.screenstepslive.com/s/documentation/m/new_user_manual_current/l/24527-pharmacy-setup
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Step 4: Set Up Structured Rx Options

You will need to access the Options menu which can be found by going to Tools  > Options.  Out 
of the Options list, you will click on the Structured Rx option. Please now refer to the Tools- 
Options lesson, and scroll down to the Structured Rx- Printing- Faxing and Structured Rx- Rx 

http://soapware.screenstepslive.com/s/documentation/m/new_user_manual_current/l/24524-tools-options
http://soapware.screenstepslive.com/s/documentation/m/new_user_manual_current/l/24524-tools-options
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Transmission sections, for further guidance.

Step 5: Use Structured Medications

Structured medications will need to be inserted into the SOAPnote Medications field for 
ePrescribing purposes. For more information, see: Medication Entry.

http://soapware.screenstepslive.com/s/documentation/m/new_user_manual_current/l/24647-medication-entry
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Q: How do I change the prescription report printed from Rx Manager?

A:  1. Select the Design from Tools > Options > Structured Rx. 

In this dialog, the default design can be changed. This setting is user- specific only.

2. Click on the Printing-Faxing tab, and then the drop down option, to change the report that will be 
used when printing prescriptions.

3. Click Close and logout out of SOAPware to save changes.
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Q: How do I build a multi-page prescription?

A: To build a multi page prescription, open Document Designer (Tools > Document Designer) to 
begin creation.

1. Click File.
2. Click Create New Design.

Enter a Document Name.
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1. Select Copy of .
2. Click to highlight the Rx- Alone Document Design.
3. Click OK to open design.

Remove the data command to enter medications from the SOAPnote medication field, by 
highlighting the command, and hitting backspace on the keyboard.
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Insert the data command,  Insert Rx's (Found from Data Items > Rx's > Insert Rx's).

The new data command has been placed onto to document design.
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1. Click Edit.
2. Select  Design Properties.

1. Click the Design Types tab.
2. Select Rx Manager Design if not already selected. Select "1" for the number of medications 
inserted.
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3. Click OK.

Click Save when closing the design, to save all changes.
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Q: When a prescription is faxed through the Rx Manager, what format is it in?

A: The prescriptions faxed through Rx Manager are in the format of the Document Design that is 
chosen from the Tools > Options menu. 

Tools - Options 

1. Click on Tools.
2. Click on Options .
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Structured Rx

1. Click to highlight Structured Rx.
2. Click on the Printing-Faxing tab.
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Choosing the Document Design 

Using the drop down arrow menu, choose the desired Document Design for printing 
prescriptions and faxing prescriptions. 
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Save the Settings 

1. Click Close.
2. Click OK, then logout of SOAPware and log back in. 
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Q: How do I add the office fax number to printed prescriptions?

A: Adding an office fax number to a printed prescription can manually be done in Document 
Designer. 

Access Document Designer by going to Tools > Document Designer.
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1. Click on File.
2. Click on Available Designs, to bring up designs to choose from.

Click to highlight the document design of choice, then Click OK to open the design.
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Place the cursor in the desired location to enter the office fax number.
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Manually type the office fax number into the desired location on the document design.
Remember to always save changes when closing the design.
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Q: How do you put a prescription on hold? 

A: The "Notes" sub-item of a medication is the area in which notes to the pharmacist can be 
documented. 

Tools - Options

To ensure that the "Notes" sub-item is present in all medications entered into the SOAPnote, a 
user will need to select it as an option. This setting is user-specific.



SOAPware, Inc.FAQ's - 140

1. Click on Tools on the menu bar.
2. Click on Options.

Setting the Default Sub-item

1. Click to highlight Structured Rx.
2. On the Default Layout tab, Click to place a check in the box next to Pharmacy Note.
3. Click Close.
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Using the Notes Sub-item

When the SMARText medication is inserted into a SOAPnote,  the "Notes" sub-item will be visible. 
1. Click next to "Notes" ( the item will turn green and small green brackets will appear).
2. Type the note to the pharmacist between the brackets. This information will be sent to the 
pharmacist via the Rx Manager. 
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Q: How do you add a provider's signature to an electronically prescribed prescription?

A: It is not necessary to place a provider's signature onto the electronically prescribed 
prescription. The signature is in the background of this transmission.
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Q: Can you generate a prescription without having to create a new SOAPnote? 

A: A SOAPnote will always need to be created when generating a prescription. Rx Manager (where 
prescriptions are derived from), reads the the Medication field in a SOAPnote. This workflow also 
keeps all prescriptions and medication history in one area. 

For refills from the pharmacy that are handled from the All Refill Request Manager, a SOAPnote 
will be auto-created when the refill is replied to, and the information will be documented in the 
Medication field for you. That SOAPnote will then need to be signed off. 
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Printing
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Q: How do I print notes for a Medicare Audit?

A: SOAPware 2010 is the first version (subsiquent versions included) to support the functionality 
necessary when an audit, such as a Medicare RAC Audit, is requested. 
Entering "Electronically Signed by" into the SOAPnote is required. This can be achieved in 
SOAPware by using a shortcut code to be part of a default docuplate that is used in the 
SOAPnotes chart section, or by entering the shortcut code in Provider Manager, under the Codes 
tab as the default follow up code.

There are multiple ways to print out what you need depending upon the situation. 
1. When printing the current docutainer with the print button located in the mini-toolbar, the sign off 
date and time will automatically be inserted.
2. Data commands for the sign off date and time may be inserted onto a document design when 
printing an Available Document Design.
3. The Share Charts workspace within SOAPware allows the printing of all or selective chart 
section docutainers to be exported. It is necessary to insert the date and time on all docutainers 
by using the keyboard command: Control + D. 

When printing the current docutainer with the print button located in the mini-toolbar, the sign off 
date and time will automatically be inserted.
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Data commands for the sign off date and time may be inserted onto a document design when 
printing an Available Document Design.

The keyboard command, Control + D, will enter the date and time into the SOAPnote. 
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The Share Charts workspace within SOAPware, allows the printing of all chart section. or 
selective chart section docutainers to be exported. 
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How do I include all documents in a docutainer when I use the quick print method?

A: When using the print button, located under the lower splitter bar in a chart section, menu 
options are available. 

Accessing the Print Button

If the bottom splitter bar is closed, left- click to expand. 
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Selecting the Documents to Print

1. Click on the Print Current Docutainer button.
2. Choose the option desired:
  *Entire Docutainer-  prints all documents in the docutainer
  *Displayed Document-  prints the document in view
  *Specific Documents- Click to highlight the document to be printed
3. Click Print.



SOAPware, Inc.FAQ's - 150

Q: How can handouts print automatically with other Document Designs?

A: A command, called Print Selected Handouts, can be placed on a Document Design. 
If handouts are selected, they will automatically print with the Document Design. 

Tools - Document Designer

1. Click on Tools on the menu bar.
2. Click on Document Designer.
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File - Available Designs 

1. Click on File.
2. Click on Available Designs.
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Selecting the Document Design

1. Click to highlight the design to place the print command.
2. Click OK.
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Edit - Design Properties

1. Click on Edit.
2. Click on Design Properties. 

Placing the Print Handouts Command on the Document Design

1. Click on the Macros tab.
2. Click to place a check in the box next to Print Selected Handouts.
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Saving the Settings

1. Click OK.
2. Click Close.
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Saving the Changes to the Document Design

Click Yes.
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Q: How do you make a Document Design print at a specific printer? 

A: A print command will be placed on the Document Design.

Tools - Document Designer 

1. Click on Tools.
2. Click on Document Designer.
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File - Available Designs

1. Click on File.
2. Click on Available Designs.
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Selecting the Document Design

1. Click to highlight the design to place the print command.
2. Click OK.
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Edit - Design Properties 

1. Click on Edit.
2. Click on Design Properties .
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Placing the Print Command on the Document Design

1. Click on the Printer tab.
2. Click on the radio button next to "Sent To:"
3. Using the drop down menu, choose the desired printer.
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Saving the Setting

1. Click OK.
2. Click Close.
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Save the Changes to the Document Design

Click Yes.
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Refill Requests
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Q: How should I respond to a controlled substance refill request?

A: Approving refill requests for a controlled substance violates ePrescribing laws. When 
responding to the pharmacy, choose the response labeled "Deny/New Rx to follow," as this is the 
ideal response to these requests.



SOAPware, Inc.FAQ's - 165

Q: How do I remove a refill request?

A: It is not recommended to remove a refill request. Denying a refill request would be the 
appropriate response. If multiple refill requests are received for one patient and one medication, 
the pharmacy should be notified. A note to the pharmacist may be entered when this refill is 
denied ,notifying them of this issue.



SOAPware, Inc.FAQ's - 166

Q: Why do pharmacies send refill requests for scheduled medications if they cannot 
be refilled electronically? 

A:  Pharmacies are using the electronic messaging option to notify the prescriber of the need for a 
refill for a patient,  rather than reverting to faxing or calling the clinician. 
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Q: Why am I not receiving electronic refills from the pharmacies that automatically 
match with the patients in SOAPware? 

A: Electronic refill requests are an evolving phenomenon which involves work flow and software 
changes from both the pharmacy and the clinic. Due to limitations of  technology linking clinics to 
pharmacies, the pharmacy has to send refill requests in a fashion that is different from past 
methods. Specifically, for automatic matching of the request to a patient, the request has to be 
directly derived from the original prescription that was sent electronically to the pharmacy. 

Many pharmacies do not yet have the software that can store the original prescription 
electronically. In fact, more often than not, the pharmacy is actually working with a fax machine, 
rather than an electronic transfer of information. In time, the software that pharmacists use and 
the standard for sharing prescription information, will allow for increased direct electronic transfer 
of prescription information, so that fewer steps are necessary from both the pharmacy and the 
clinic. 

A major limitation to efficiency, at present, is the lack of any unique identifiers for patients. It is now 
illegal to use  Social Security numbers. Currently, the only means to uniquely identify (match) 
patients with prescriptions, is to use the original identifier associated with the initial prescription 
sent from the clinician to the pharmacy. 

**If a clinician is receiving no refill requests that automatically match to patient charts, there may 
be a discrepancy between the prescriber information sent from SOAPware, and what Surescripts 
has on file for a clinician.**
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Sales Specific
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Q: Does SOAPware offer a return period?

A: SOAPware does have a return policy. 

Return Policy

As long as you are within 30 days from the date of purchase you can return SOAPware for a full 
refund of the purchase price. 

Sales Contact Information

Phone: 800-455-7627, ext. 200
E-mail: sales@soapware.com
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Q: How do I see my SOAPware license? 

A: The SOAPware Site Administration page will display what enhancements or package you have 
with SOAPware, as well as check the renewal dates for the SOAPware license. 

Tools - Provider Manager

1. Click on Tools on the menu bar.
2. Click on Provider Manager. 
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Provider Manager

 Within the Provider Manager, Click on the button with the green plus. 
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Site Administration Page

Licensing information will be displayed. 
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Q: How many office staff can use each SOAPware license? 

A: For local installs of SOAPware, SOAPware is licensed by provider. This allows as many office 
staff , not including providers,  to be using SOAPware at the same time.

For the SOAPware Hosting Service: SOAPware Clinical Suite includes 5 connections for the first 
provider, and 3 connections for each additional provider. With SOAPware Professional, each 
provider license comes with 3 connections per provider. 
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Q: How many computers can I install SOAPware on? 

A: SOAPware is licensed per provider. This allows installation of SOAPware on all computers in 
the office, as well as on home computers if needed; without increasing the price of the 
SOAPware. 
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Security
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Q: Is there a way to lock users out of the ability to customize or reset toolbars? 

A: This setting is user and computer specific, and therefore cannot be limited within security.
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Q: Why does my newly created chart section not show up in Chart Navigator? 

A: When a new chart section is created, all users will need to be given access to view it within 
Security. 

For information on Security,  click here.

http://soapware.screenstepslive.com/spaces/Documentation_2011/manuals/new_user_manual_current/chapters/12006
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SOAPware Cloud Solution
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Q: On the SOAPware Cloud Solution, how do I control the size of my screen?  

A: A user is able to control the size of their screen on the SOAPware Cloud Solution by accessing 
the display tab, where resolution settings can be chosen. 

Access the Remote Desktop Connection

 Click on Remote Desktop.

Options

Click on Options. 
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Display Tab

1. Click on the Display tab.
2. Set the absolute size or choose Full Screen, and the Colors depth.
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Some Considerations 
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Q: How do I logout/disconnect from my SOAPware ASP Server? 

 

A: There are different ways to logout/disconnect from your SOAPware ASP Server, and not all have 
the same effect.  

Below discusses the methods for logging out or disconnecting, and the effects of each on your 
session and data.

NOTE:  Logging out of SOAPware and disconnecting from the ASP Server are two distinct 
actions.  It is possible to logout of SOAPware while remaining connected to your ASP Server.

To logout of the SOAPware application, choose the menu option SOAPware > Logout or Exit 
SOAPware.
This method:

    * only closes SOAPware and has no effect on your ASP Server connection or any other 
application on your ASP Server.
    * will save all data you have entered into SOAPware.
    * is the recommended way to close SOAPware before ending your SOAPware ASP session in 
order to minimize the risk of data loss.

To Disconnect from your SOAPware ASP server : 

 This allows you to leave SOAPware and other applications running on your ASP Server when you 
disconnect.  SOAPware will continue to run on your server so that when you reconnect you can 
pick up your work in the same place.

If you plan to be away form the computer for a short time (such as when changing rooms), this is 
a simple way to make a new connection from another computer without having to shutdown all 
your open applications.

If you plan to be away from the computer for an extended period, it is highly recommended that 
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you Log-Off from your server rather than disconnect, due to potential data loss. (See the 
Logging-Off section below.) 

While you are disconnected, scheduled events (scheduled backups, maintenance, server 
updates, etc) or unscheduled events (hardware failure, emergencies, disasters) at the SOAPware 
data center could cause your ASP Server to reboot or close SOAPware, which will cause any 
unsaved data or documents to be lost. 

There are four ways to Disconnect from your server:

    * Clicking the Close Button in the upper right-hand corner of the Remote Desktop window.
    * Right-clicking the Remote Desktop window title bar and choosing Close.
    * Click the Start button on your ASP Server and choose Shutdown.  Select Disconnect from the 
drop down box and click OK.

If you plan to be away from the computer for an extended period, it is highly recommended that 
you Log-Off from your server rather than disconnect, due to potential data loss. 

Logging-Off is the recommended method to end your SOAPware ASP Server connection.  Your 
connection is closed properly and all changes made to your SOAPware ASP Server Desktop will 
be saved.

Closing SOAPware (and any other open applications) before Logging-Off your ASP Server using  
this method is the surest and safest way to minimize the possibility of data loss.

There are 2 ways to Log-Off from your server:

    * Click the Start button on your ASP Server and choose Log Off.
    * Click the Start button on your ASP Server and choose Shut Down, then select Log Off from the 
drop down box and click OK.
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Q: How do I import images into a chart via the Remote Desktop?  

A: The concept of importing images is very simple.  This process is documented for end-users 
who wish to transfer files from their local computer (client) to the SCS server (server), to import 
into SOAPware, or to utilize their virtual server as an cloud repository for documents.  In response 
to this need, we have responded with a utility called “DocTrans”. This small utility transfers files 
from the client’s computer to the server.  The files can then be transferred into SOAPware using 
SOAPware’s “Document  Importer” or transferred to a folder of the end-users choice.

Configurations 

Two quick configurations are needed to allow DocTrans.exe to work properly:

• Your local C:\ drive must have a folder with the exact name of “shstrans”  (C:\shstrans).  If you 
don’t have the knowledge or authority to make this folder, please see your system 
administrator. The folder on the server should already exist, if not please call support at 
800-455-7627.

• Configuration of the “Remote Desktop Connection” application is required for the 
DocTrans.exe to work.
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Local Resources- Windows 7

• Open the Remote Desktop Connection application on your computer (client).
• Choose the Local Resources tab.
• In the Local devices and resources section, click the More button.
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• The second RDP dialog box will be displayed.  Check the box next to Drives.
• Click OK.

Connect as you normally would, however, at this point you may receive a security notice that you 
are going to be connecting your drives to the Remote Desktop Computer.  This is expected, and is 
the function we want.  At this point, the configuration steps are finished on this PC & only need to 
be completed once on each of the client computers you use.

Local Resources- Windows XP

 

• Open the Remote Desktop Connection application on your computer (client).
• Make sure the Options button is clicked to display the Option tabs.
• Choose the Local Resources tab.
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• Under the section Local devices and resources click the More button.
• Make sure your C:\ drive is selected.
• Click OK and then back to the General tab.

Connect as you normally would, however, at this point you may receive a security notice that you 
are going to be connecting your drives to the Remote Desktop Computer.  This is expected, and is 
the function we want.  At this point, the configuration steps are finished on this PC & only need to 
be completed once on each of the client computers you use.

 

Transfer Image/Document(s) to the VPS

• At this point, you have the folder created and the Remote Desktop Connection application 
configured to connect your C:\ drive to the server.

• You can now save/drop any Image/Document(s) into the C: \shstrans folder on your local 
computer.

• Double-click the DocTrans application on the server desktop, and the contents of the SCS 
trans folder will be uploaded to the server.

• You will see a DOS window appear showing you that status of the image/document(s) 
transfer, once complete a window will appear displaying the contents of the C:\shstrans 
folder. 
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Importing the Image/Documents(s) into SOAPware

• Double-click the SOAPware Icon & login to SOAPware as you normally do.
• Once SOAPware is open, click SOAPware > Document Import > the Document Importer 

Workspace will appear, which contains 4-panes to operate in: Chart Rack, Drive/Folder 
Selection, File Selection, & Chart Section.

• In the Chart Rack Pane, pick a patient > in the Drive/Folder Selection Pane, pick a location to 
browse for your files; in this example it would be C:\shstrans > in the File Selection Pane, 
select the file(s) you want & drag them to the Chart Section you would like them saved in.

• You have successfully imported your Image/Document(s) into SOAPware. 

Things to Remember

• The DocTrans will only transfer 10MB or less at a time. This protects you from using all your 
bandwidth for long periods of time.

• The DocTrans will overwrite existing files with the same name. For example if you have a 
scan called MRI.jpg in the server's C:\shstrans folder and you upload another file called 
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MRI.jpg, it will overwrite the first.
• The DocTrans only moves files from the clients C:\shstrans to the servers C:\shstrans, it 

doesn’t move them the reverse direction.
• The DocTrans places the documents on the server for easy import into SOAPware, it does 

not move them into SOAPware.
• Once a document has been moved into SOAPware with the “Document Importer” it can then 

be deleted from the server's C:\shstrans folder. This is actually encouraged as you don’t want 
to use all your free space on the C:\ drive with documents.
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Q: How do I connect to the SOAPware Cloud server?  

A: The SOAPware ASP program allows for users to connect to the SOAPware application from 
anywhere in the world using Microsoft's Remote Desktop Connection Application.  RDC, as we 
will call it from here forward, is a tool for running a computer remotely. With RDC you can utilize 
our remote servers just as if you were sitting in front of it. There are RDC applications for almost 
every operating system, including Macintosh. 

Connect to the ASP server

1. Click on Start.
2. Click on All Programs.
3. Click on Accessories.
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4. Click on Remote Desktop Connection.

Enter the DNS (Domain Server Name) 

1. Enter the DNS (this will be supplied to the clinic contact person).
2. Click Connect. 

Login Screen

The next screen you will see is your log on screen. Here you will enter your user name and 
password to the VPS server. Each user name and password is unique for each server and each 
clinic has it's own server.
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Remote Desktop View

Once logged in, you will see a desktop much like your local desktop.  From here you can launch 
the SOAPware application or any other application you have purchased.  



SOAPware, Inc.FAQ's - 193

Q: How do I print from a Remote Desktop Connection (RDC)?  

A: Give a list of the printers in the clinic, to the Support Team at SOAPware. The Support team will 
then install the print drivers on the ASP server to make the printers available from the server. 
You may submit this information in a Support ticket at www.soapware.com/ticket.

After this step is completed, the option of  "printers" must be selected on the Remote Desktop 
Connection. 

Q: Access the Remote Desktop Connection 

1. Click on the computers Start menu.
2. Click on Remote Desktop Connection. 

http://www.soapware.com/ticket
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Local Resource/Printers

1. Click on the Local Resources tab.
2. Click to place a check in the box next to printers.
3. Click on the General tab.
4. Click on Connect to connect to the Remote Desktop.
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Q: How does a Remote Desktop Connection "Session" work?  

A:  Terminology for understanding "Session" concepts:

Session - An independent desktop environment capable of running a set of programs on a server 
with set permissions based on user name and passwords which persists regardless of outside 
connectivity.

Remote Desktop Connection - A Microsoft program that allows you to start, connect to or stop a 
"session".

Terminal Session - implies connectivity from the client (Remote Desktop Connection) to the 
server.

If a user logs onto the server and simply clicks the X to close the Remote Desktop Connection 
program, they have only disconnected from the server. In other words, they have stopped the 
Terminal Session. The environment or what is called a "session"   is still open and running on the 
server. All the programs that have  been opened are still running back at the server and as far as 
the server is concerned,  connectivity has been lost and it’s patiently waiting for to reconnection. 

The upside of leaving a session open is:

• The user can close this connection at the current computer, go to another computer and log 
back in with the same user name and password, and be right back in the "session" where 
they left it when they disconnected.

• The user doesn't have to wait for SOAPware to load, they simply log in.

The downside of leaving a session open is:

• That session uses up a terminal licenses, and the clinic only has a set number of them.       
• If for some reason the user has an unsaved encounter information or other unsaved data and 

the session is reset by another user whom logs in and unknowingly closes programs without 
saving, the server is rebooted or in the event of a server crash, that data will be lost.       

• If a user is   logged into SOAPware with high permissions, and someone with lower 
permissions logs into the session, they can see what the first user was  working on.  It's 
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important that session accounts and SOAPware accounts match in permissions.  For 
example, if the front desk staff only has the ability to pull a chart or create a new chart in 
SOAPware, the do not need the user name and password to the doctor or nurses Remote 
Desktop Connection Session. 

Note: It is our recommendation, when a user is  finished working in a session, at the very least, 
close the patient's chart (that saves the data) then log out of SOAPware (this keeps any of the staff 
without permission from seeing patient data).  

To log out of SOAPware click the menu item File >  Logout.

Leaving a session open is not in itself bad, as long as you have logged out of SOAPware by 
Clicking the menu item, File > Logout  The absolute safest measure is to Click the Task Bar's, 
Start > Log off buttons. Logging off the session closes all programs and releases the Terminal 
Session licenses.
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Q: How do I scan into SOAPware on the SOAPware Cloud Solution? 

A:  Due to limitations with Windows, document scanners cannot directly scan into the SOAPware 
Cloud Solution. However, there are some options:

Option #1
Scanners from Ambir Technology (an approved SOAPware Partner) are specifically designed to 
work with the SOAPware Cloud Solution. These scanners have been tested and verified to work in 
the SOAPware Cloud Solution environment. For more information, visit 
http://www.ambir.com/SOAPware. 

Option#2 
Click here for a lesson that goes over how to scan locally & import your Document(s) over to your 
SCS server for importing into SOAPware.

Option #3
There is third party software available that gives Windows Remote Desktop the ability to access a 
scanner from your local computer. The software programs listed below are currently being used 
by a number of SCS Users and SOAPware, Inc. has no complaints concerning their usage.

• TSScan - Remote Desktop Scanning by Terminal Works.

http://www.ambir.com/SOAPware
http://soapware.screenstepslive.com/s/documentation/m/scs/l/31731-q-how-do-i-import-images-into-a-chart-via-the-remote-desktop
http://www.terminalworks.com/remote-desktop-scanning/


SOAPware, Inc.FAQ's - 198

Q: What controls the speed of my ASP server?  

A:  

The first, and most influential, factor is bandwidth. Bandwidth is the potential amount of data that 
can move across the Internet connection. Internet connections can be purchased from ISPs for 
amounts from 28.8 Kbps to 10Mbps. As with RAM or CPU speed, more is always better. 

Remote Desktop Connection (RDC) has the ability to fine tune the servers to accommodate a lack 
or abundance of bandwidth. In the RDC application under the "Experience" tab, are settings from 
the most limited connections (Modem 28.8Kbps) to the highest available (LAN 10Mbps or higher). 

In our tests we have found that most connections operate optimally at the Modem 56Kbps setting. 
Choosing a lower setting doesn't limit the connection speed, only the Experience. In fact, the 
lower the Experience setting, the faster the ASP server will seem to react and run, as it has to 
move less data over the Internet connection for any given task.

While it is possible to connect to the server via a 28.8 or 56 Kbps Modem, we have found that at 
least a 128 Kbps connection is needed for real-time interaction.

To optimize the connection, start off with the most basic settings possible, and gradually increase 
them until the server's reaction seems to slow down, then move back down to the previous 
setting. A good starting point is to set the connection speed to Modem 28.8 Kbps, the display to 
640x480, and the display colors to 256. 

The optimal configuration is a trade-off between perceived reaction times and display quality. 
Users may prefer different settings depending on their needs. 
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Q: Why won't printers load into a Remote Desktop Session? 

A:  When you connect to your SCS Server, and go to Start > Control Panel, > Printers and 
Faxes--and  nothing displays, this is a known Microsoft Windows XP issue and Microsoft has 
addressed it in a support article.

The reason for this behavior is that by default, Terminal Services only supports printer's that begin 
with COM, LPT, or USB.

The fix for this is fairly simple,  as you will need to follow the following 6 steps:

1. Click Start > Click Run>  type "regedit" >  and then Click OK.
2. Locate and then Click the following key in the registry: 

HKEY_CURRENT_USER\Software\Microsoft\Terminal Server Client\Default\AddIns\RDPDR
3. On the Edit menu > point to New > then Click DWORD Value.
4. Type "FilterQueueType", and then press ENTER.
5. On the Edit menu, Click Modify.
6. Type "FFFFFFFF", and then Click OK.

These steps allow all printer ports to be redirected inside Terminal Services/Remote Desktop.

To see the actual Microsoft Support document, Click here. 

http://support.microsoft.com/default.aspx?scid=kb;en-us;q302361
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Q: Can I run SOAPware on a Mac computer through SCS?

A: Yes, a user can run SOAPware on a Mac computer through SOAPware Cloud Solution.

For more information on SOAPware Cloud Solution, Click here.

Download Remote Desktop Client

For a free version of Remote Desktop Client for Mac 2.1.1, Click here.

http://www.soapware.com/products/
http://www.microsoft.com/en-us/download/details.aspx?id=18140
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Launch Remote Desktop Connection for Mac

1.  Double-click on the "Remote Desktop Connection" icon at the bottom of the screen.
2.  Type in your computer name and Press "Connect."
3.  Type in your credentials and Press "OK."

System Preferences 

Double-click on the System Preferences icon at the bottom of the screen.
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System Preferences- Keyboard

1.  Click on "Keyboard."
2.  Check the first box that refers to the standard function keys.

Checking this box will allow the Mac user to still use the function keys for their intended function, 
however the Fn key must be pressed first on the keyboard, and then select a function key at the 
top of the keyboard.
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System Preferences- Mission Control

1.  Click on "Mission Control."
2.  Reset the "Show Desktop" option (which will be set to F11) to a function key that is not already 
used in SOAPware, such as F15. 
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Launch SOAPware

Double-click on the SOAPware icon. You may then log in and proceed to use the function keys on 
your keyboard, to bring up the intended actions in SOAPware.
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SMARText
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Q: What do the triangle colors next the SMARText Items mean? 

A: SMARText Items will have a green, red, or yellow triangle next to them in the SMARText Items 
Manager, as well as when results from a Shift F11 or F11 search is displayed. 

Explanation of Triangle Colors

    *  Red - These denote CPT items that have been edited by users and uploaded to the Cloud 
Library. Due to the AMA's copyright on CPT items, they can be edited by users, but not shared. 
Meaning, these items cannot be downloaded. 
    * Green - These are trusted items.  This means that the items were created by SOAPware, Inc. 
staff.
    * Yellow  - These are items that were created or edited by users.  These items can certainly be 
used by other users, but It is simply unknown if the item will work correctly or not. 
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Q: How do I change a SOAPware created shortcut code to my own shortcut code? 

A: Users can change the shortcut code to any SOAPware created structured SMARText item. 
However, in any release prior to SOAPware 2010.2, when all local SMARText items are updated , 
the edited SMARText item will not update. 

If any section of the SMARText item, other than the shortcut code for users with SOAPware 2010.2 
and subsequent versions, is edited (i.e. Description, Display Header etc), the item will not be 
updated. 

Accessing the SMARText Manager

1. Click on Docutainers on the menu bar.
2. Click on SMARText Items. 
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Select the Item to Edit

1. Type the keyword of the item to edited in the Find box.
2. Click on the find button.
3. When the item is displayed, Click to highlight the item.
4. Click on the edit button.
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Change the Shortcut Code

1. Remove the existing shortcut code.
2. Type in the desired code.
3. Click Save. 
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Q: Why do some words expand into text when I don't want them to, and how do I 
resolve this issue?

A: The option to turn off "Expand Items with Space bar," can be done from the Tools menu item. 

1. Click on Tools.
2. Click on Options.
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1. Click on SMARText in the Options list.
2. Uncheck the box next to "Expand Items with Space Bar."
3. Click Close.

It is very important to Logout of SOAPware to save the changes. 
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To Logout out of SOAPware:
1. Click on the SOAPware menu item.
2. Click Logout.
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Q: How do I use existing SMARText items as the basis for new ones? 

A: Existing SMARText items can be duplicated and modified by the user. 

Note: It's very important not to change the fundamental meaning of duplicated items. For 
example, if you duplicate Tylenol, do not change the name to Amoxicillin. The coding system (in 
the background) for the item will still identify it as Tylenol in the computer and in the database. 

It is also very important to make edits to the duplicated item and not the original. The duplicated 
item can be determined by checking the values in the Last Modified column in the SMARText 
Items Manager. 

Access the SMARText Items Manager 

1. Click on Docutainers.
2. Click on SMARText Items to access the SMARText Items Manager.
Or, press F10 on the keyboard.
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Search for the SMARText Item

1. In the SMARText Items Manager, type a keyword in the Find box.
2. Click on the Find button.

Duplicate the SMARText Item

1. Click to highlight the desired SMARText item.
2. Right-click on the item and choose "duplicate."
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Access the Duplicated Item

Now there will be two of the items in the list. The duplicated item will appear with a yellow triangle 
and the "Last Modified" date will display the date of the duplication.

Open the SMARText Designer

1. Click to highlight the duplicated item.
2. Click on the Edit button.
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Make the Desired Changes

1. Within the SMARText Designer, make the changes to the Shortcut, Description, Keywords and 
Display Header as needed.
2. Click Save.
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Q: How do I add a comment or free text to a structured item? 

A: To add a comment to a structured SMARText item is referred to as "the click and type method". 

The click and type method does not work with medications. 

Activate the Structured Item

Left-click directly on top of the SMARText item the comment will be attached to.  (meaning, place 
your cursor within the SMARText item)

Add a Comment

1. After left-clicking on the SMARText Item, start typing the desired comment. 
The comment box will not appear until you start typing. 
2. Click Save or press the Enter key on the keyboard. 



SOAPware, Inc.FAQ's - 218

The Result

The free-text comment will now be "attached" to the SMARText item. 

To edit the comment, simply left-click on top of the comment, and press the spacebar on the 
keyboard. The Item Comment box will display, so that the comment can be edited. 
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Q: How can I change the wording and appearance of SMARText in my 
documentation? 

A: The appearance, or text , of a SMARText Item, can be changed. For example, the "Chief 
Complaint" SMARText item can be changed to display "Reason for Visit" or "Patient complaines 
of."

Access the SMARText Items Manager 

1. Click on Docutainers.
2. Click on SMARText Items.
Or, press F10 on the keyboard
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Locate the SMARText Item

1. Type the shortcut code or keyword of the SMARText item to be edited into the Find box.
2. Click on the Find button. 

Highlight the Desired Item

1. Click to highlight the item to be edited.
2. Click on the Edit button.
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Edit the Item

 In the Display Header box, not the blue text in the large text box for it will change 
automatically, change the text to appear as desired. Click Save.

Use the Edited Item

When the shortcut code is inserted into the Subjective field, and the spacebar is pressed, the 
SMARText item reads "Reason for Visit" rather that "CHIEF COMPLAINT (S)." 
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Q: How do I update SMARText items? 

A: Updating local SMARText items is an easy process. We, however,  recommend that this is not 
done during clinic hours as the speed of SOAPware will be compromised. 

We recommend this process to be completed every two weeks to once a month, at a minimum. 
Updating SMARText only needs to be performed on one networked computer. 

Prior to updating SMARText items go to Tools > Security and disable the Idle Logout function by 
unchecking the box next to Logout user.

Disable Idle Logout Before Updating SMARText

Prior to updating SMARText items go to Tools > Security and disable the Idle Logout function by 
unchecking the box next to Logout user.

Logout of SOAPware for this change to take effect then log back in and follow the steps below.
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*Note:  To protect elctronic health information go back into security and enab le idle logout after 
the SMARtext update is complete.  

Access the SMARText Items Manager 

1. Click on Docutainers.
2. Click on SMARText items 
Or, press F10 on the keyboard

Update SMARText Items

1. Click on the Update Local Items button with the light bulb image.

Note: We do not recommend updating SMARText for the clinic during clinic hours, as this process 
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will slow down the speed of SOAPware for everyone on the network,  and can take anywhere from 
20 minutes to 2 hours to complete. 
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Q: Why do I get a "Connection Failed" error when attempting to update SMARText? 

 

  

A: Downloading and updating SMARText Items depends on establishing and maintaining a 
consistent connection to the SOAPware Cloud Library servers.  Normally this is handled by your 
computer and network equipment and requires no additional effort on your part.

 

In some cases, though, there may be problems in the chain of communication that can adversely 
impact the connection.

 

If you receive "time out" errors when connecting to the Cloud Library, there are several possible 
causes: The first thing to do is to re-try the update later in the day or at a time that Internet or your 
network traffic is likely to be lower. Other considerations…

 

   1. A problem with that computer's network connection.  Test the connection by trying to access 
resources (files, printers, etc) that are stored on another computer on the local network.

       
   2. A problem in your local network.  There could be wires, hubs, or routers in your local network 
that are damaged or failing.  This would be indicated by widespread connectivity problems in your 
office, from multiple computers and in multiple applications.

       
   3. A problem with your internet service provider.  If your ISP's network is having trouble, you will 
have slow or reduced speed connections to the Internet.  Test this by trying to reach large, reliable 
sites (such as www.google.com) or by running speed tests (such as those at 
www.speakeasy.net).
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   4. A problem with SOAPware's servers.  If you have verified that your computer, local network, 
and internet connect are all functioning properly, contact SOAPware to report your problem.  We 
can verify the state of our servers and connections and help you troubleshoot the problem.

In summary, there are a whole host of issues that can cause the connection to be problematic, 
resulting in time-outs. In the middle of the day, when Internet traffic is highest, one can expect 
there to be more problems. In contrast, updating in the middle of the night should result in the 
fewest problems with time-outs.
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Q: Is there a good way to download a large amount of structured medications at 
once? 

A: The user would search in the SMARText Items Manager by type, and bulk-download the 
commonly used medications. 

Access the SMARText Items Manager

1. Click on Docutainers in the menu bar.
2. Click on SMARText Items .
or press F10 on the keyboard
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List by Type

Within the SMARText Items Manager, Click on the  List by Type  tab.
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Medication Items

1. Click on the drop down arrow.
2. Click on the + (expander node) next to Generic.
3. Click on the expander node next to Structured Items.
4. Click on Medication Item.
5. Make sure there is a check mark in the box next to Include Cloud Library Items.
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Searching

A dialog will display indicating this action will take "many minutes"  (typically 10-15 minutes) to 
complete. 
Click Yes  if ready to continue. 

Download the Medication Items

1. Holding down the Control key on the the keyboard, click to highlight the medication items to be 
downloaded.
2. Click on the download arrow to download these medications into the local database. 
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Q: How do I load the SMARText Quick Access with my top SMARText items? 

A: The SMARText Quick Access will display the items previously inserted by a user in a particular 
field when the cursor is placed in that field. For example, when the cursor is placed in the 
Medications field, all previously used SMARText items will be displayed in the SMARText Quick 
Access. They can quickly and easily be inserted by double-clicking on the item. 

To pre- populate these lists, place your cursor in the Medication field, for example, and insert the 
top 20-30 SMARText medications that are used. This can also be done in the Assessment field 
with diagnosis, and the Plan Field with CPT codes. 
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Summary/SOAPnote Specific
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Q: How do I clear/empty a field under a field header in the Summary or a SOAPnote?

A: Clearing/emptying fields in the patient's Summary or SOAPnote chart section, only requires a 
few steps. See below for an example of how to empty/clear the contents within the Medication field.

Right- click on the field header (e.g. Medications). Select "Empty Medications" from the list in the 
display window.
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Q: How do I add or remove the Provider name in the Follow Up field?

A: A user is able to add or remove a Provider's name in the Follow Up field from Provider Manager.

1. Click on Tools.
2. Click on Provider Manager ,to display the provider's information.
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1. Click to highlight the Provider to add/remove name from the Follow Up field.
2. Click the Codes tab.
3. Select or deselect to Append Name to Follow Up Field on SOAPnote Creation.

To save changes, Click the Update button.
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Q: Can I hide or remove certain field headers in the Summary or SOAPnote chart 
sections?

A: Yes, it is possible to hide/remove a field header from the Summary or SOAPnote chart 
sections. This change will reflect on newly created patient charts, but not on existing patient 
charts. 

To remove the unwanted field headers, open the Docuplates window. This can be achieved by 
pressing F6 on the keyboard,  or by clicking  Docutainers > Docuplates.
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To search for a docuplate, enter the name of the docuplate into the search field. Click the Search 
button.
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A list of docuplates for the "summary" search will display in the window. The docuplate in need of 
modifying is usually the default docuplate for a particular chart section.
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Highlighting a docuplate, will display the information in the docuplate preview window.
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Right-click at the very bottom of the docuplate,  and Select,  "Manage Sub Items."
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The field headers in the Summary default docuplate will display in the SMARText Quick Access 
Window.

Deselecting field headers will hide/remove the field headers, and reflect this change in the current 
docuplate displayed in the docuplates window.
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ROS and Physical field headers have been removed/hidden in the current docuplate selected.
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Q: How do you reassign ownership of a SOAPnote to another Provider?

A: To reassign a current SOAPnote to another provider, Click on the Reassign button in the 
mini-toolbar located behind the lower splitter bar. 

*Note: If a SOAPnote has been signed off, the provider/ownership cannot be reassigned.

Click the Reassign Documents button to change the provider ownership of document.
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1. In the Owner column, Click on the name of the existing owner to receiving the drop down 
menu.

2. Select the correct Owner/Provider from the drop-down menu.
3. Click OK to save the changes.

The new Owner of the document will now display in the document list.
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Q: How do I import my signature directly into the SOAPnote or Encounter? 

A: There is a SMARText item type called "Clinician Signature," which will import the signature that 
has been imported into Provider Manager, into the SOAPnote. 

For instructions on importing the signature into Provider Manager, click here.

Access the SMARText Items Manager

1. Click on Docutainers on the menu bar.
2. Click on SMARText Items
or press F10 on the keyboard

http://soapware.screenstepslive.com/spaces/documentation/manuals/new_user_manual_current/lessons/24521-Provider-Manager
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Create a SMARText Item

Click on the Button with the green plus.

Custom SMARText Item

Click on the radio button next to "Custom."
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1. Using the drop-down arrow, Click on the + (expander node) next to "Generic."
2. Click on the expander node next to "Controls."
3. Double-click on "Clinician Signature."

Create 

Click on the Create button.
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SMARText Designer

1. Assign the SMARText Item a shortcut code.
2. Type in a description.
3. Type in keywords, single words separated by commas for searching purposes.



SOAPware, Inc.FAQ's - 249

4. Click Save. 

Insert the Shortcut Code into the SOAPnote

In an open SOAPnote, in the Follow Up field, type in the shortcut code, and press the spacebar.
The signature will be displayed.
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Q: How do you document phone calls and/or e-mail messages received from patients?

A: Phone calls for medication refills, email messages, test results or just patient triage phone 
calls, should be documented in the SOAPnote chart section of a patient's chart.  This allows any 
patient documentation to be signed off, preventing alteration of patient information. 
Documentation relating to a patient phone call, plan, any medications prescribed, and follow up, 
can be documented in one centralized area area.
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Q: How can a patient's past visits be viewed while also viewing the current 
encounter? 

A: The "Encounter Viewer" dialog can be utilized to see multiple patient encounters at one time. 

The "Encounter Viewer" dialog can also be docked. 

Access Encounter Viewer Dialog

1. With a chart open, Click on Tools.
2. Click on "View Previous Encounters."
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Encounter Viewer

The Encounter Viewer dialog box will be displayed. This can be dragged to any position on the 
screen, and also docked if desired. 

To view a previous encounter, simply click to highlight the line item (encounter). 
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Add a Previous Encounter to the Current Encounter 

Make sure a new encounter is open and with the previous encounter desired in view, Click "Add 
Active Document to Current Encounter." This action will transfer the entire previous note into the 
new/current encounter. 
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Add a Previous Field to the Current Encounter

Make sure a new encounter is open and with the previous encounter desired in view, Click next to 
the field that is to be inserted into the current SOAPnote. Click "Add Active Field to Current 
Encounter." This action will transfer that field only to the current SOAPnote. 
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Q: How do I enter "Electronically Signed By" into my SOAPnote?

A: The shortcut "esb" will need to be uploaded to your local library so that it may be inserted into 
the SOAPnote Follow Up field. This code insertion can be done automatically when entered in the 
Provider Manager/Codes Tab.

Download Shortcut "esb"

Open SMARText Items Manager by using the F10 key located on the keyboard, or go to 
Docutainers > SMARText Items.

From within SMARText Items Manager, enter "esb" in the "Find" window and Click the Search 
button.
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Click to highlight the item for "Electronically Signed," and Click on the download button to 
download this item to your local library.
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Insert Code in Provider Manager

After this item has been successfully downloaded to your local database/library, go to Tools > 
Provider Manager, to enter this shortcut in the Codes tab to be automatically inserted into the 
SOAPnotes Follow Up field.
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Codes Tab in Provider Manager

1) Click to highlight the preferred provider in list to add shortcut code.
2) Click on the Codes tab.
3) Insert the shortcut "esb" in the Default Follow Up field.
4) Click Update.
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Support Specific
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Q: I renewed my support agreement but still get a pop up asking me to renew. 

A: If after renewing your support agreement, a provider's license might need to be refreshed. 

Tools - Provider Manager

1. Click on Tools.
2. Click on Provider Manager.
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Refreshing the License Change

1. Click to highlight the desired provider.
2. Click on the blue download arrow.

Logout and back into SOAPware for changes to take effect.
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Version 4
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Q: How do I convert my old V4 shortcut codes into structured SMARText items?

A: Version 4 shortcut codes can be reassigned to a structured SMARText item.  This will allow the 
user to continue using familiar shortcut codes with the new structured SMARText Items.

1.  Search for and Download Structured SMARText Items

To search for and download a structured SMARText Item:

1.  Type the diagnosis, medication or CPT description into the appropriate field (ex: type "asthma" 
into the Assessment field).
2.  Press Shift + F11  on your keyboard to search for a structured SMARText item.
3.  Locate the correct diagnosis and double-click on it to download and insert the item.
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2.  Change the Shortcut Code for the Structured SMARText Item

Next, we will change the shortcut code for our newly downloaded SMARText Item to be the 
shortcut code that we are familiar with using in version 4:

Open the SMARText Items Manager by pressing F10 on the keyboard.

1.  Un-check the Include Cloud Library Items box.
2.  Search for the item that you wish to assign a new shortcut code to (ex: In the above screenshot, 
we searched on the diagnosis ICD9 code.  Users can also search using the name of the 
diagnosis, medication or CPT code).
3.  Highlight the newly downloaded SMARText Item and click the Edit button.
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4.  Change the current shortcut to the shortcut code that the user is familiar with from version 4.
5.  Click the Save button to save your changes.
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3.  Delete the Old Version 4 Shortcut Code from the Users Database

Now that we have changed the shortcut code for our newly downloaded SMARText Item to the 
shortcut code the user is familiar with from version 4, we need to delete the old obsolete code. 

1.  In the SMARText Items Manager, search using the shortcut code.
2.  You should see two items in your search results.  One item will be your newly downloaded 
SMARText Item.  This item will have a Type of either "Dx", "Rx", or "ST Plan Item".  The second item 
will be your old version 4 shortcut code.  This item will have a Type that says either "(US)" for 
unstructured or "(Obsolete)".  Highlight the old shortcut code and press the Remove (red X) button.
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After removing the old version 4 shortcut code, this should leave only the newly downloaded 
SMARText item remaining in the users database.  

4. Insert the New SMARText Item Using the Shortcut Code

To insert the new SMARText Item using the shortcut code you assigned:

1.  Return to the SOAPnote and type in the shortcut code.
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2.  Hit the spacebar on the keyboard to expand the item.

The structured SMARText Item will be inserted using familiar version 4 shortcut code.
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Q: When reassigning V4 shortcut codes to a structured SMARText item, how can this 
change be permanent? 

A: Version 4 shortcut codes will need to be removed from the local database. 

In the image above, notice that there is an unstructured Asthma diagnosis with the shortcut of 
"AsthmaX". There is also a structured SMARText item for this diagnosis with the same shortcut of 
"AsthmaX." 

Highlight the unstructured diagnosis (indicated by the "US" in the type column) , and Click the 
delete button to remove the V4 unstructured SMARText item.  The structured SMARText item will 
now be what is left on the local database. 
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Q: Why are my print reports from V4 not printing out the patient's name/dob/address 
in SW 2012?

A: It is possible that the data command that was placed on the V4 report, is not pulling the 
information over onto the report in 2012. The data command will need to be replaced with the 
appropriate 2012 data command.

Access Document Designer

1. Click on Tools.
2. Click Document Designer.

1. Click on File.
2. Click Available Designs.
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Open the Design

1. Click to highlight the Document Design to edit the data commands.
2. Click OK to open the design.
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Place the cursor point in the location of choice to add the data command, or remove the V4 data 
command, in order to insert the new 2012 data command.
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Insert the 2011 Data Command

1. Click Data Items.
2. Click General Demographics.
3. Click Birth Date.
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The data command for Birth Date has been inserted in the Document Design.

1. Click Close.
2. Click Yes to save changes to that Document Design.
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Q: Where are my templates from Version 4?

A: Version 4 templates can be retrieved in Docuplates. 

Docuplates can be found by pressing F6 on the computer keyboard, or from the Docutainers 
Menu Item, click on Docuplates (as shown in the screenshot above).
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1. Enter the name of the Version 4 template.
2. Click the Search button to view Docuplates.

*Note: Placing a check in the box next to Include Cloud Library Items, will bring up a list for all 
Docuplates that have been created by SOAPware and uploaded to the Cloud Library by 
SOAPware users.
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Vital Signs



SOAPware, Inc.FAQ's - 278

Q: How do you add another Vital Sign to the Vital Signs chart section?

A: A user is able to add another Vital Sign reading type from the Vital Signs chart section. 

Select a Reading Type

Click on the Select Reading Type button to view the Select Vital Readings window. 
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Select Vital Readings Window

1. Click to highlight the Vital Reading.
2. Click OK to add the preferred reading to the default reading types in a patient's chart.
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Added Reading Type

The selected reading type will be added to the vital signs chart section for this particular patient.
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